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Chapter 19 Printing

This chapter covers the PDF printing of single sheets, entire plan sets, and other miscellaneous workflows.
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RECORD OF REVISIONS

The following record of revisions to the OpenRoads Designer Manual Chapter 19 is offered as a “quick reference” to

determine the latest changes.

DATE SECTION

REVISION DESCRIPTION

12/2025 General

Updated estimating software reference to Masterworks

4/2025 Section 19F.1

Roll Plot size updates. Inclusion of WFL capability in-house.
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19A - PLAN SET PRINTING (BATCH PRINTING)

Plan Sets are printed from the Print Organizer tool. The Print Organizer is a batch printing utility for printing multiple sheets into a single PDF.

A Print Set File - which contains the file extension “.pset” - is a set of Plan Sheets. There are two approaches for Plan Set printing:

e Create a single Print Set File that includes all sheets in the Plan Set (preferred).

e Create a Print Set File for each Section in the Plan Set

The graphic below shows a Print Set File that represents an entire Plan Set. Each Section of the Plan Set is organized into Sub-Folders.

Print Set File
(.pset)

currently loaded

Parent Folder
Contains the entire
Plan Set

Sub-Folders

created for each
Section in the Plan Set

File Edit View Tools
LJEEHEC

A General
----- B. Summary of Quantities
I; - C. Typical Section
D. Plan-Praofile
E. Approaches and Turnouts

F. Soil Erosion and Sediment Cc
. Drainage

H. Temporary Traffic Control

J. Permanent Traffic Control

K. Structures

Bridge

Environment

X-Sections

Print Organizer

Ad A General
A General
A. General
A. General
A. General

C. Typical Section
C. Typical Section

C. Typical Section

D. Plan-Profile
D. Plan-Profile

Printer Setup p

t Organizer - - *
ORD Plan Sheet Model
Sheet Name Sub-Folder N (3
Sheet File hame
MName Folder File Name Model View
L AT A General SYM=DINO11|[3].dgn Symbols 1
A2 A General SYM_DINO11(3).dgn Symbaols 2 I
LAl A General LAMRIFTMP.dgn Alibates

STE(
STE(

LAl Each Row corresponds
[ with a single Plan Sheet.
STE
STEE Typically, Plan Sheets
TYR( are created from
TYP( Sheet Models [ .

Connections ...

Plan 1 [Sheet]

Plan 2 [Sheet] w
>

TYP(UPAT)ETNP.dgn
PNP(UPAT)FTNP.dgn
PNP(UPAT)FTNP.dgn

d = FLH_Standard_PDF.pltcfg § 20 items (0 selected)

BEST PRACTICE: When viewed in PDF Software (i.e., Adobe, Blue-Beam), the resulting PDF will contain bookmarks created from the Sub-
Folders and Sheet Names as arranged in the Print Organizer. Assign Sub-Folders and Sheet Names logical names that agree with the
plan set Sections and numbering scheme.
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TIP: To ensure Fields (i.e., Sheet Numbers, Project Information) are up to date before printing, use the
Update Sheet Model Properties tool found in the Sheet Index (found in the Explorer 'ﬁ.). All Sheet Models
[ must be added to the Sheet Index to use this tool. See 19B.1 Update Text Fields Before Printing
(Update Sheet Model Properties tool).

The overall process for batch printing through the Print Organizer is shown below:

Access the Print Organizer

19A.1 Access The Print Organizer

L 4

Create a New Print Set File (.pset)
19A.2 Create a New Print Set File (.pset)

EFL Users: EFL uses a blank Print Set File (.pset) template for plan set printing. Do NOT
create a new Print Set File (.pset). Instead, copy the EFL Print Set File (.pset) template to the
project folder. Load the blank Print Set File (.pset) template as shown in 19A.3 Load a Print
Set File (.pset).

Create a Sub Folder for each Section in the Plan Set
19A.4 Create Sub-Folders

Add Sheets to the Print Set File (.pset)
19A.5 Add Sheets to the Print Set File (.pset)

TIP: External PDFs can be added to the Print Set File (.pset). For example, PDFs generated
from Masterorks can be incorporated in the Print Set File. By doing so, it is unnecessary to
manually insert external PDFs into final PDF printed from the Print Set File (.pset).

COLOR PRINTS ONLY: Remove the FLH Pen Table
19A.6 Printing Properties, the FLH Pen Table, and Color Prints

Print the Print Set File (.pset)
19A.7 Print the Print Set File (.pset)
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19A.1 Access the Print Organizer

There are two locations for accessing the Print Organizer.

LOCATION 1: the Search Ribbon Bar, type in “Print Organizer”.

; Type in
": i v r . n H H
‘J OpenRoads Modeling gl "Pl'lnt Organlzeru

=8 DGN] - OpenRoads Designg] Print organizer h

Backstage (1)

Home Terrain Geometry Site into the search Bar
#. None * | Default M é ‘.| T

2 |

Eo ~|mo -|=o0 ~|@e - Select

Attributes Print Organlzer

Show Details

LOCATION 2: Go to File - Print -> Print Organizer

a}'ﬂ OpenRoads Modeling + g2 H bi‘:; |T,:_; o v A f |_E_‘J * C\Users\brendan\Desktop\NEW

Home Terrain Geometry Site Carridors Model Detailing Drawing Productiot

@ OpenRoads Designer CE 2021 Release 1 | rP - f._.\ ® h @ T -0 X

Print

New

Dp.:_lﬂ r
H] Print Print to a printer or to a file

Save

Save As _@'\1 Print Preview Open the resizable print preview window
Save Settings

Send Mail g Print to POF Print to 2 PDF document

Close

Print Styles Create, edit, and delete print styles

Tools
Settings

i: Print Organizer Print multiple files using Print Organizer
Properties - L

2 Print

Import

Export -

- 0 X
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19A.2 Create a New Print Set File (.pset)

A new Print Set File (.pset) is created directly from the Print Organizer.

ALTERNATIVELY: The Sheet Index can be used to generate a new Print Set File (.pset). All Sheet
Models [ in the Sheet Index are automatically arranged into a Print Set File (.pset). See 19B - Sheet

Index Printing.

EFL Users: EFL uses a blank Print Set File (.pset) template for plan set printing. Do NOT create
new Print Set File (.pset), Instead, copy the default Print Set File (.pset) to the project folder.

Open the copied Print Set File (.pset) - as shown on the next page.

o Access the Print Organizer. See 19A.1 Access the Print Organizer.

When the Print Organizer is initially opened, a blank Print Set File will be loaded. The blank Print Set File
will be named “Untitled.pset”. To create a new Print Set File, simply Save the blank Print Set File.

= Blank Print Set File (.pset
Print Organizer ”Untitled.pset”( P ) — X
File Edit View Tools
L3155 Q1 |55 & A ANV NMIE|
View Gro

File Name

ame Folder

...... .

Press Save H
to Name and Specify the File location for
the Blank Print Set File

Maodel

Il
a Save Print Set File X
&« v 1 « Proje.. » 6975 Riverside Road Impro... ~ (&) O Search 6975 Rivers...
Organize ~ New folder = = = 0
Specify the File Location
- . . ~
Plot_Config Name for the new Print Set File
Printing >
I Desktop cfg | 0 items (0 selected)
@ OneDrive - DJ&A, Name the new Print Set File v
® Brandan Mo raur i S >
File name: | Riverside Road Plans.pseﬂ v
Save as type: |Print Set Files (*.pset) e
- Directory ~
l ~ Hide Folders Save the new Print Set File H&%J Cancel

E Riverside Road Plans.pset rganizer J
File Edit P HSkaaEe After saving, the name of the
L-%l» = L__‘ = @ = new Print Set File is shown in
the top-left.

Name

/
—
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19A.3 Load a Print Set File (.pset)

When the Print Organizer is initially opened, there will be NO Print Set File (.pset) loaded. Go to File >
Open to load a previously-created Print-Set File (.pset).

TIP: Recently used Print Set Files (.pset) are shown at the bottom of the File drop-down (see below). A
recently used Print Set File (.pset) can be quickly loaded from this location.

ﬂ Untitled.pset IPrint Organ

is shown here.

WARNING: The loaded Print Set File

If "Untitled.pset” is shown here, then

& ¢

Select Open.

Save As...

Default Print Definition Name...
Output File Names...

Add Folder to Set
Add Files to Set.
Add Active File to Set...

Print Preview
Printer Setup...

Print...

1 C\Users\brendan\CFL DGNs\Yale Kilgore Road.pset

2 Ch\Users\brendan\CFL DGNs\Crater Lake.pset

3 C\Users\brendan\CFL DGNs\Riverside Road.pset

4 C\Users\brendan\CFL DGNs\Harpers Corner Road.pset

TIP: Alternatively, a recently
used Print Set File can be
quickly loaded from this location.

File Go to File no Print Set File is loaded.
4 New CUTT
: cr+o |
Save Cirl+S File Name Model

rd_PDF.pltcfg |D items (0 selected) .

Exit

e

E'j Open Print Set File

pa

v TI « Projects (F:) » 6975 Riverside Road Improvements * dagn

Navigate to the folder location

that contains the Print Set File
Organize ~ New folder =~ [N
~ . - .
# Quick access Name modified Type Size
[ Desktop » D Riverside Road.pset :56 PM PSET File 673 KB
6839.002 WFLHI A
—————— - Select the desired
File - Print Set File
File name: |Riverside Road.pset v ‘ Print Set Files (*.pset*.job) b
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19A.4 Create Sub-Folders

BEST PRACTICE: When setting up a Print Set File (.pset) to print the entire Plan Set, create Sub-

Folders for each Section in the Plan Set. If printing a single section of the Plan Set, then Sub-Folders

are NOT necessary.

IMPORTANT: When viewed in PDF Software (i.e., Adobe, Blue-Beam), a bookmark is created for each

Sub-Folder. Assign logical names to Sub-Folders. Sub-Folder names should agree with the plan set
organizational scheme.

File

'ﬂ Riverside Roag

L-HI- =] —

ans.pset - Print Orl

Select (highlight) the Parent Folder

WARNING: If a Sub-Folder is

Edit ew  Tools highlighted, then a folder is created
under the highlighted Sub-Folder.
T e e |
b Press the File Name Model A\
B. Summary of Quantities Add Folder to Set
C. Typical Sections| | icon _4 .

Type the Name of the
Sub-Folder and push
the ENTER key.

L%‘u FLH_Standard_PDF.pltcfg | 0 items (0 selected) .

ﬂ Riverside Road Plans.pset - Print Organizer

File Edit View Tools

LW

— >

----- B. Summary of Quantities

..... C. Typical Sections

..... D. Plan and Profile

----- E. Approaches and Turnouts

..... F. Soil Erosion and Sediment Control
..... G. Drainage

..... H. Temporary Traffic Control

----- J. Permanant Traffic Control

..... K. Structures

D s —_— — -
| | | — \‘) |- + N\ AV ! | i T|Le
Riverside Road Plans Mame Folder File Name Model
----- A. General

Folder Structure
for the Plan Set

L%J FLH_Standard_PDF pltcfg | 0 items (0 selected) .
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19A.5 Add Sheets to the Print Set File (.pset)

The following types of sheets can be added to the Print Set File (.pset):

Sheet Models [=: Typically, printing is performed with Sheet Models [2. Each Sheet Model [
corresponds with a sheet in the Plan Set. See 19A.5.a Add Sheet Models to the Print Set File (.pset).

PDFs: PDFs that were created from Excel or other software can be incorporated into the Print Set File
(.pset). For example, Summary of Quantities PDFs (i.e., B-Sheets generated from Masterworks) can
be added to the Print Set File (.pset). By doing so, external PDFs do NOT have to be manually
inserted into the Plan Set PDF. See 19A.5.b Add PDFs to the Print Set File (.pset).

2D Design Model 21 sheets: With Legacy Software, such as GEOPAK and ORD SS4, plan
production and printing were performed in the 2D Design Model Q. Legacy Detail Files are
occasionally encountered and incorporated into plan sets. Legacy Files contain a Plot Shapes and/or
Fences to define the printing area for each sheet. See 19A.5.c Add Sheets from the 2D Design model
to the Print Set (.pset).
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19A.5.a Add Sheet Models to the Print Set File (.pset)

The Add Files to Set tool is used to add Sheet Models [ to the current Print Set File (.pset). With this
tool, an ORD File is selected and all Sheet Models [ contained in the selected ORD File are added to the
Print Set File (.pset).

ﬂ Riverside Road Plans.pset - Print Or

File Edit View Tools

L+BH =

« - Riverside Road Plans

..... A. General

----- B. Summary of Quantities

..... C. Typical Sections

..... D. Plan and Profile

----- E. Approaches and Turnouts
..... F. Soil Erosion and Sediment Control
..... G. Drainage

..... H. Temporary Traffic Control

----- J. Permanant Traffic Control

..... K. Structures

Press the
Add Files to Set

icon -. Hame Model Viev

Add Files to Set

Select (highlight) the
Sub-Folder that the
Sheet Models[ 3 belong to.

L‘;I'd FLH_Standard_PDF.pltcfg | 0 items (0 selected)

ALTERNATE TOOL: The Add Active File to Set tool will add all Sheet Models [2 from the currently
opened ORD File to the Print Set File (.pset). After this tool is used, proceed to Step 5.

- Print Organizer - *
ew Ctrl+N
- Open Ctrl+O
Model Viev
H Save Ctrl+5
Save As...
Default Print Definition Name...
Output File Mames...
[ 4 Add Folderto Set
% Add Files to Set.. Go to File.
Add Active File to Set..
| Print Preview Use the >
|| Printer Setup.. Add Active File to Set tool. }©selected)

=4 Print...

1 C\Users\brendan'Desktop\MEW ORD CAD Files\CFL DGNs\Riverside Road Plans.pset
2 Ch\Users\| t
scwsers\| If the Add Active File to Set tool is
4c\users\l  used, then proceed to Step .

5 CA\Users\, - - - r—— set
Exit
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Create Print Definitions X

Input Files
C:\Users\brendan\Desktop\NEW ORD CAD Files\Riversidelid-a2158061_pln_pp.dgn e Push the Add button to specify
[SS the ORD File that contains the
Remove Sheet Models [ .

Specify a Print Style by ) Select the )
pushing the button. N - FLH_Standard_PDF
. pply Print Style Print Style
Print Definition Creation Options SEEEAMILEEmETTy ‘
Print Style Mame File Name

Print style name:
L. PDF PrintStyles.dgnlib

L Printer PrintStyles.dgnlib
{“ FLH_Standard_PDF LI\\r Print_Styles.dgnlib

| FLH_standard_PDF |

Manually Specified Options. ..

caes coree
7
Select OK to add the

Sheet Models[&
to the Print Set File.
Select Files - C\Users\brendan\Desktop\NEW ORD CAD Files\Riverside, >
Look in: | Riverside g
* Name Date modified 3 -
_ Eﬁ;‘id—a2158061_ali.dgn , Nawgate t-O the ap[_Jroprlate
Quickaccess =4 22158061_cor.dgn 11/18/2021 3:41 ORD File location.
- Eﬂid—aﬂ 58061_cor_appr.dgn 11/6/2021 418 P
% did-a2158061 pin pp.dgn 11/18/2021 9:33 Specify the ORD File that
Desktop &)id-22158061_sup. b 53p| contains the Sheet Models [3.
— Eﬂid—a2158061_sur.dg 11/4/2021 8:40 A
m ﬂid—a2158061_ter.dgn 10/21,/2021 12:3Q Push Done.
Libraries ald—a?l 58061_)(s.dgn 11{‘6/2021 5:40 Pl DoTTOCy e o te . 7T e g v
File name: id-a2158061_pln_pp.dgn ~ | Done
Files oftype: All Supported Files (*.dgn;*.dwg;" tif,“ tiff, . itiff, " bmp;*.jpg;” jpeg.” jpe;*.cal” cals;".ct1;".sid," png;".pdf)y Cancel
hd Options
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19A.5.b Add External PDFs to the Print Set File (.pset)

In this example workflow, the Summary Quantity Sheets (B-sheets) PDFs are added to the Print Set File

(.pset). This process is convenient because the Summary Quantity Sheets PDFs do NOT have to be

manually inserted into plan set PDF.

WARNING: When adding PDFs
to the Print Set File, do NOT
apply a Print Style Name or

Manually Specified Options.

ﬂ Riverside Road Plans.pset - Print Orggpi - X
File Edit View Tools
[.;'.E?H| B @ |.‘j. e Press the
~ Riverside Road Plans Add .FIIES O Set 3 Model Viev
il A General Add Files to Set icon UOf.
B. Summary of Quantities
C. Typical Sections
D. Plan and Profile Select (highlight) the
E. Approaches and Turnouts H -
F. Soil Erosion and Sediment Control approprlate SUb FOIder
G. Drainage to place the PDF into.
H. Tempaorary Traffic Control
J. Permanant Traffic Control
K. Structures
< >
|= FLH_Standard_PDF.plicfg | 0 items (0 selected) .;
Create Print Definitions X
Input Files
C\Users\brendan\Desktop\|D_BOUNDARY_5806(1)\EEBACS E-Sheets pdf P Push the Add button to specify
s the PDF File to add to the
Remove Print Set File.

Print DQ‘IDI’\ Creation Options

Print style name:

Manually Specified Options...

Select OK to add the
PDF File

~

SN Cancel to the Print Set File.
Select Files - C\Users\brendan\Desktop\ID_BOUNDARY_5806(1)\ X
Lookin: |~ ID_BOUNDARY_5806(1) G T E- BH®

*

Name Date modified Type Size
| &) EEBACS B-Sheets.pdf 8/2021 436 PM Adobe Acrobat Do... 378 KB :

Ly

Quick access

Navigate to the appropriate
PDF File Location.

Desktop
= Select (highlight) the PDF File.
m
Libraries Push Done
File name: EEBACS B-Sheets. pdf ~ | | Done
Files oftype: All Supported Files (".dgn:*.dwg:" tif “tift.".itif.".bmp* jpg:* jpeg” jpe:".cal”.cals".ctl " sid" . png:".pdf)  ~ Cancel
hd Options
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19A.5.c Add Sheets in the 2D Designh Model to the Print Set File

In legacy forms of the software, such as GEOPAK or OpenRoads SS4, printing was performed from 2D
Design Models & (this is because Sheet Models [2 were yet to be invented). In this workflow, a detail
sheet, created with GEOPAK, is added to the Print Set File (.pset).

Legacy Files contain a Plot Shape element, which designates the area to be printed and represents the
total page size.

Open the ORD File which contains the standard detail.

Determine the Level which the Plot Shape is assigned to.

TIP: For FLH legacy Files, typically, the Plot Shape Level is “"D_Plot_Shape”. However, the Plot
Shape Level should always be verified before adding to the Print Set File (.pset).

NOTE: In later steps, the Level name will have to be manually typed into an input box. The
Level name must be typed in exactly to be identified by the Print Organizer.

B View 1, US Customary 2D DeS’gn MOdel I.--I;IJ E@
@B~k 4 PRLEHDERS ST

o

Determine the Level
of the Plot Shape.

In this case, the Level

is "D

lot_Shape".

o e

TIP: Hover the Mouse Cursor B .
over the Plot Shape with the JOINT SEALING DETAILS
to reveal the Level.
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‘ ‘Open the Print Organizer. See 19A.1 Access the Print Organizer.

EJ Riverside Road Plans.pset - Print On - >
Eile Edit View Tools
|:-i|- ] H ‘ — Q: .r_:: Press the
~ - Riverside Road Plans Add _Flles _. Set a Model Viey
----- A. General Add Files to Set icon 3.
----- B. Summary of Quantities
..... C. Typical Sections
----- D. Plan and Profile . .
----- E. Approaches and Turnouts SEIECt (hlghllght) the
----- F. Soil Erasion and Sediment Control Sub-Folder that the
----- G Drainags Standard Detail belongs to.
----- H. Temporary Traffic Control
----- J. Permanant Traffic Control
----- K. Structures
< >

= FLH_Standard_PDF.pltcfg | 0 items (0 selected)
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Create Print Definitions X

Input Files
C\Users\brendan\Deskiop\[D_BOUNDARY_5806(1)\C501-50.dgn Add Push the Add button and locate
s the ORD File that contains the
Remove 2D Design Model ¢] and
F Standard Detail.
Specify a Print Style by
Print Definition Creation Options DUShing the bUtton-

Print style name:

| FLH_standard_POF | L.
=

Manually Specified Options...

‘ Double-Click in the Levels
box and type in the Plot
Push the Shape Level.
Manually Specified Options Push the
button Okay button IMPORTANT: The Level
- | must EXACTLY match the
e ¢ - Plot Shape.

Select the
Fence tab

Main  Advanced Fence Display Levels References

Fence - Define from shape

Model Options
Search Shape properties
Use these models to create pnint definitions Level
Master model ciels
-

Reference files D_Plot_Shape
| Fence Creation Methods Select the
| -
. - Define From Shape
| i X
[ - option

i g s Define from shape. ..
¢

Tt Define from cell .

‘(9! Eittomaster model
1 Colors: (0-255) | |

'f Fit to master model and all reference files | |
=l

See NOTE below Weights: (0-31)

Styles: (0-7) | |

',“ Fit to element range. ..

;a's;? Enter fence points... - = -
00, (® Create one print definition from first matching shape

() Create one print definition for each matching shape

Cancel

Push the
Okay button

Cancel

s

NOTE: If the legacy file contains multiple Plot Shapes (i.e., multiple sheets in the same legacy file), then
select the Create one print definition for each matching shape option. This option will seek out all
Plot Shapes in the legacy File. With this option, a sheet will be added to the Print Set File (.pset) for each
Plot Shape.

Use the default option, Create one print definition from first matching shape, if the legacy file
contains a single Plot Shape/Sheet.
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19A.6 Print Properties, the FLH Pen Table, and Color Prints

When the “FLH_Standard_PDF” Print Style is applied, NO other Print Properties settings must be

configured.

TIP: The “FLH_Standard_PDF” Print Style is applied when sheets are added to the Print Set File
(.pset). See STEP 5 in 19A.5.a Add Sheet Models to the Print Set File (.pset).

However, to print a sheet in color, the FLH Pen Table must be removed. For more information on

color printing, see 19E - Color Printing Workflow.

NOTE: Elements on the AUX_01 - AUX_10 Levels are ignored by the FLH Pen Table. The AUX
Levels will print in the color shown in the ORD Software. In the Level Manager, manipulate the

Color symbology of AUX Level to the desired color for printing. See 19D - The FLH Pen Table,

Custom Levels, and the AUX Levels.

Remove the FLH Pen Table: To remove the default Pen Table, select a sheet(s) and push the

Properties @: button. Highlight and delete the file path text shown in the Pen Table setting box.

Access the Print Properties and
Remove the default Pen Table

Resymbalization
|Pen Table» Pentable:

\OpenRoads Designer CE\Configuration\Organization\T ables\Pen\Black bl

Design script: |

Push OK. oK Cancel

EJ Harpers Corner Road. JeEr=rrmCorganzer - X
File Edit View Tools
| f— ) = [hy = . .
15l S5 X Select (highlight) the
Neme Fold®r i desired sheet(s) and push ~
A General A1 A General sym ool the Properties button @J.
B. Summary of Quantities WA2 A General SYM_DINO11§
C. Typical Section A3 A General v STE[LAMRFTNP dgn  Alibates
D. Plan-Profile WA4 A General be STE(LAMR)FTNP.dgn  Blue West
;- E Approaches and Tumouts || g o5 A General STE(LAMR)FTNP.dgn  Fritch Fortress
. . . TNP.dgn Harbor Bay
e TIP: Select (highlight) multiple sheets, the  bpagn  sanforavake
Parent Folder, or a Sub-Folder to change TNP.dgn  Vicinity Map
Properties settings for multiple sheets at once. [TNPdgn  Road Typical Seci.
r - e T T AT SEC o TreToErr 1 NP.dgn Road Typical Secti.. Plan2Views  View1
Bridge H_ﬁce, C. Typical Section TYP(UPAT)FTNP dgn Connections Detail
Environ
X-Secti{ C.2 Properties X
Main  Advanced Fence Display Levels References -
< >
Filename: |C:\Users\brendan\Desklop\NEW ORD CAD Files\CFL DGNs\TYP(UPAT)FTNP.dgn
selected)
Area Paper
Print area: |Fence ~ Papersize: | ANSIB b
Model: 'Road Typical Sections 2 [Sheef] Limits: 17.000x 11.000 in
View group: | Plan 2 Views ~ Orientation: | Landscape ~
View: View 1 ~
[ Rasterized
Layout
Units® | ip e
Scale: (0.0833:1.0000
Size: [17.000 11.000 -+
origin' (9000 o0 ] Certer Delete the File Path Text
: shown here.
More. ..
Refresh Show design in overview
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TIP: Scroll the Print Organizer window to the far right to see the Pen Table applied to each sheet.

ﬂ Untitled.pset - Print Organizer

File

Edit View Tools

Efilﬂ“ééﬁE;Q‘if:

Applied Pen Tables

L;L

[ SUM{LAMR)FTNP
[ SUM(LAMR)FTNP
[ SUM(LAMR)FTNP
[ SUM({LAMR)FTNP
[ SUM({LAMR)FTNP
-~ SUM({LAMR)FTNP
-~ SUM({LAMR)FTNP
[ SUM{LAMR)FTNP
[ SUM({LAMR)FTNP
[ SUM{LAMR)FTNP
[ SUM(LAMR)FTNP
[ SUM(LAMR)FTNP
[ SUM({LAMR)FTNP
[ SUM({LAMR)FTNP

F o1 IRAA ARACE TR

”~

Print Area Pen Table ~
Fence Black.tbl

Black.tbl

Black.tbl
Fen Black.tbl

Black.tbl

BN @A ANV VIEL
Name NOTICE: Most sheets use the
(LAMR)FTNP "Black.tbl" Pen Table.
(LAMR)FTNP
ILaMR)FTNP] However, a few sheets have no Pen
ILaMR)FTNPY Table assigned for color printing.
I(LAMR)F TNP S e e e T S N T O T T
[(LAMR)FT i e T
:(ﬂg)g: Move the Scroll Bar to ew:
- 2w
émmn;m the far right to see o
wawvrrFy  Applied Pen Tables e
[(LAMBR)F T My w1
I(LAMR)FTNP.dgn Miscellaneous 4 llaneo... View1
ILAMR)FTNP.dgn Miscellaneous 5 Misce o.. Miewl
<

Fen

Fence

Fence

Fence Black.tbl

Fence Black.tbl

Fence Black.tbl

Fence Black.tbl

Fence Black.tbl v

»

= FLH_Standard_PDF.pltcfg | 16 items (1 selected) .:
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19A.7 Printing the Print Set File (.pset)

Before printing select (highlight) one of the following:
e an individual Plan Sheet,
e a Sub-Folder (prints an individual section)
e the Parent Folder (prints the entire plan set)

Only the selected sheets or folder will be printed.

Print icon &
Select the Parent Folder, a

»
k.4 Harpers Corner Rg Sub-Folder, or a Single Sheet - X
file Edit Viewly Tools before printing.
L‘?l' ':E:' H Q‘] '._.g.' ‘ P NV ! i
i Harpers Comer Road o EFolder File Name Maodel ~
;&5 A General - Select (Highlight) the gn Symbols 1
= ”““99 Parent Folder to print ALL Sheets fan  Symbols2
: v in the current Print Set File. [dgn  Alibates
D. Plan-Profile S el =reTemmrOTrTee .dgn Blue West
» - E Approaches and Tumouts || jg a5 A General STE(LAMR)FTNP.dgn  Fritch Fortress
select (Hig h |ig ht) a ﬁ AB A General STE(LAMR)FTNP . dgn Harbor Bay
Sub-Folder to print a Section :ﬁA.? A General STE(LAMR)FTNP . dgn Sanford Yake
} A A General STE(LAMR)FTNP . dgn Vicinity Map
of the Print Set. @c C. Typical Section TYP(UPAT)FTNP.dgn  Road Typical Sections [Sheef]

: R _:’ms gc2 C. Typical Section TYP(UPAT)FTNP.dgn Road Typical Sections 2 [Sheet]
Bridge fca C. Typical Mction TYP{UPAT)FTNP.dgn Connections Details [Sheet]
Environment g D Plan-Pro PNP( BlanllShooll
*-Sections @®D2 D. Plan-Profi PNPd Select (Highlight) 2 Row v

< | "1 to print a single sheet. ?
ek

ﬂ L—!'I"Eﬂm P elected)

Ensure that the
Print Driver Configuration is set
to "FLH_Standard_PDF.pltcfg".

Print

Printer Driver Configuration

| File name:  FLH_Standard_PDF pltcfg |

Type: Bentley PDF printer driver

Printer Setup...

Print Range Copies
: Change the Submit as to
QL TIP: Ch the Submit as t
O Selection Separate Print Jobs to create
. a separate PDF for each Sheet.
Submit
Create printfi
| Subrmitas: [single printiob - Desitination: Specify the
Destination: |3ndaniDeskiop\NEW ORD CAD Files\CFL DGNs\Harpers Comer Road.pdf| .. desired File Location with
] Open print file after creation the [.] button.

TIP: Check this box to open
the PDF after creation. Push OK 0K Cancel

STEP 2: If the Print Driver Configuration is NOT set to “"FLH_Standard_PDF.pltcfg”, then push the
Printer Setup button and locate it on in the FLH WorkSpace at the following location:

OpenRoads Designer CE 10.10\Configuration\Organization-Civil\FLH_Stds-WS10.10.21.00V\Printing\Plot_Config
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19B — SHEET INDEX PRINTING

A Print Set File (.pset) can be generated directly from the Sheet Index.

The overall process for batch printing through the Sheet Index is shown below:

Setup and populate the Sheet Index
Chapter 18 - Sheet Index

Update Fields found in the Sheet Models [2 (i.e., Sheet Numbers)
19B.1 Update Text Fields Before Printing (Update Sheet Model Properties tool)

In the Sheet Index, use the Open Print Organizer *: button
to generate a new Print Set File (.pset)

19B.2 Create the Print Set File (.pset) from the Sheet Index

OPTIONAL: Remove the Pen Table for Color Prints
19B.3 Enable Print Properties Settings and 19E Color Printing Workflow

OPTIONAL: Add External PDFs to the Print Set File (.pset)
(i.e. Summary of Quantity Sheets produced by Masterworks)

19A.5.b Add External PDFs to the Print Set File (.pset)

Print the Print Set File (.pset)
19A.7 Print the Print Set File (.pset)
WARNING*: A brand-new Print Set File (.pset) is generated each time the Open Print Organizer % tool
is used from the Sheet Index. After initial generation from the Sheet Index, save the Print Set File
(.pset). For future prints, do NOT go through the Sheet Index. Instead, re-access the Print Set File

(.pset) through the Print Organizer as shown in 19.1 Access the Print Organizer and 19A.3 Load a Print
Set File (.pset).

EFL WARNING*: The EFL Agency Print Set File (.pset) template CANNOT be used when printing through
the Sheet Index.
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19B.1 Update Text Fields Before Printing (Update Sheet Model

Properties tool)

The Update Sheet Model Properties tool can be used on Sheet Models [2 that belong to the Sheet Index.
This tool will force all Sheet Numbers and Text Fields in the Sheet Model L3 borders to automatically

refresh.

BEST PRACTICE: Always use this this tool before printing from the Sheet Index to ensure Sheet
Numbers are up to date. When using this tool, select (highlight) the Parent Folder to update Field

information for all Sheet Models [ in the Sheet Index.

WARNING: This tool does NOT update Fields found in the 2D Design Model 2 or Drawing Models &,
To update Fields found in 2D Design Model 2 or Drawing Models @, see 19F.4 Update All Fields in an

ORD File.

w Items

ﬁ-l Resources

& Sheet Index

Qi RE @0,

&, Explorer -

[ File

>

v

OpenRoads Model

Right-Click on the
Parent Folder and select the
Update Sheet Model Properties

S

*® Harpers Comner Road (46)
A, General (8)

B. Summary of Quantities

VOV W

C. Typical Section (3)

4 D. Plan-Profile (3)

> [3D.101,12] Plan 1 [Sheet]
> [ D22 13] Plan 2 [Sheet]
> [ D33, 14] Plan 3 [Sheet]

Validate
Update Sheet Model Properties

.; Details

®E Properties

[ E. Approaches and Turnouts (2)
[ F. Soil Erosion and Sediment Control {2)
[ G. Drainage (6)
[ H. Temporary Traffic Control (7)
[ J. Permanent Traffic Control (4)
1
'E Links

TIP: This tool could be used
with an individual Sub-Folder
or Sheet Model [
~

OpenRoads Standards
Drainage and Utilities Model

Survey

v

v

19-20



19B.2 Create the Print Set File (.pset) from the Sheet Index

' il

The Open Print Organizer

the Parent folder is Selected then sheets contained within will be added to the Print Set Files (.pset).

[

'd, Explorer

¥ Items
OpenRoads Model

¥ Sheet Index

Sheet Index

Open Print Organizer
£ icon

PR '® Harpers Corner Road (63)

A. General (8)

B. Summary of Quantities

C. Typical Section (3)

D. Plan-Profile (3)

E. Approaches and Turnouts (2)
F. Soil Erosion and Sediment Control (2)
G. Drainage (6)

H. Temparary Traffic Control (7)
J. Permanent Traffic Control (4)
K. Structures (6)

Bridge (4)

Environment (&)

R ™ e

X-Sections (41)

Select the Folder to create the
Print Set File (.pset) from.

If the Parent Folder is selected
(highlighted), then all sheets in
the Sheet Index are included

in the Print Set File (.pset).

icon will create a Print Set File (.pset) from the currently selected/highlighted folder(s) in the Sheet Index. If

Select Print Style

Print Style Name
LLPDF

.{,Printer

“MF| H_Standard_PDF

Select the

File Name
PrintStyles.dgnlib
PrintStyles.dgnlib
Print_Styles.dgnlib

"FLH_Standard_PDF"

Print Style

Cancel

OpenRoads Standards v
Drainage and Utilities Model

Survey

EJ Harpers Corner Road.pset - Print Organizer

Print Organizer

File Edit View Tools
1 — b s f— -
LEEIEBRRE XA A v ¥E- i
Al Harpers Comer Road Name Folder File Name Model Print Style
A General B A1 A General SYM_DINO11(3).dgn Symbaols 1 FLH_Standard_PDF
B. Summary of Quantities @A2 A General SYM_DINO11(3).dgn Symbols 2 FLH_Standard_PDF
C. Typical Section A3 A General STE(LAMR)FTNP.dgn  Alibates FLH_Standard_PDF
D. Plan-Profile @ A4 A General LH_Standard_PDF
E. Approaches and Tumouts A5 A General : FLH_Standard_PDF
F. Soil Erosion and Sediment Confrol @A6 A General A” ShEEtS are |n'|:| UdEd FLH_Standard_PDF
G. Drainage @A7 A General in the Print Set File. [ standard_ror
H. Tempaorary Traffic Contral @[rA8 A General . = — LH_Standard_PDF
J. Permanent Traffic Control (1 C.Typical Section TYP(UPAT)FTNP.dgn Road Typical Secti.. FLH_Standard_PDF
K. .Structures fc2 C.Typical Section TYP(UPAT)FTNP.dgn Road Typical Secti.. FLH_Standard_PDF
Brld_ge L C3 C.Typical Section TYP{UPAT)FTNP.dgn Connections Detail.. FLH_Standard_PDF
Environment D D.Plan-Profile PNP{UPAT)FTNP.dgn Plan 1 [Sheet] FLH_Standard_PDF
X-Sections N~ V- RO IR A TIE TR R Mmoo AroL-_a R R S
< >

[= FLH_Standard_PDF pltcfg | 41 items (0 selected) _:

WARNING*: A brand-new Print Set File (.pset) is generated each time the Open Print Organizer

%

project Print Set File (.pset) has already been generated, then print from that. See 19A.3 Load Print Set File (.pset).

tool is used from the Sheet Index.

If a
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TIP: A Print Set File (.pset) can be created from one or more selected (highlighted) Sub-Folders. Hold down the CTRL key to select multiple
Sub-Folders

Open Print Organizer

Sheet Index

%2 icon

& Itemns -

. OpenRoads Model v
¥ Sheet Index -~

N - -

Qi IB < Print Organizer

4« @H C Road (41 _

arpers Corner Road (41) ﬂHarpersCorner Road.pset - Print Organizer B X

A. General (8)
File Edit View Tools

B. Summary of Quantities [J.EH |[%] Q_] ‘.:—:. ‘ ANNVY ‘E

C. Typical Section (3)

|2
a4

. Harpers Comer Road Mame Folder File Name Madel Print Style
D. Plan-Profile (3) 5. D.Plan-Profile i
" D1 D.Plan-Profile PMNP(UPAT)FTMP.dgn Plan 1 [Sheet] FLH_Standard_PDF
E. Approaches and Turnouts (2) > E Approachesand Tumouts ||| g o D plan-Profile PNP(UPATIFTNP.dgn  Plan2[S FLH_Standard_PDF
F. Soil Erosion and Sediment Co %ﬁ'DB D. Plan-Profile PMNP(UPAT)FTMP.dgn Plan 3[S FLH_Standard_PDF
ffE1  E Approachesand T.. TYP{UPAT)FTNP.dgn Approach T .. FLH_Standard_PDF

(fE2 E ApproachesandT.. PRK(UPAT)FTNP.dgn Parking Lot [Sh FLH_Standard_PDF

H. Temporary Traffic Control (7)

J. Permanent Traffic Control (4)

TIP: Hold down the CTRL Key to
select (highlight) multiple Sub-Folders

K. Structures (&)

Bridge (4
- (= FLH_Standard_PDF.plt

| 5items (0 selected) .-

Environment ()

I
[
b
I
[
b
[ (. Drainage (6)
[
b
I
[
b
I

X-Sections (41)

Only Sheets belonging to
the selected (highlighted)

. OpenRoads Standards v .
o P o Sub-Folders are included
. Drainage an ilities Mode . - -
’ in the Print Set File.
. Survey A
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19B.3 Enable Print Properties Settings

When printing through the Sheet index, initially, the ONLY Print setting available is the Print Style.
Use the Convert to fixed print definitions tool to gain access to the full array of Properties setting.

NOTE: This tool must be used to gain access the Pen Table settings for color printing.

C.
. Typical Section

TYP(UPAT)FTNP.dgn
TYP(UPAT)FTNP.dgn

(
STE(LAMR)FTMP.dgn
push the Properties E

Road Typical Secti...
Road Typical Secti...

ﬂ Harpers Corner Road.pset - Print Organizer — x
File Edit View Tools
— — B — -
el = =180 AANV NI
= MName Foldler File Name Madel Print Style ~
> -5 A General @A1 A Gq Properties | SYM_DINO11(3).dgn Symbols 1 FLH_Standard_PDF
-~ B.Summary of Quz @ A2 A General SYM_DINO11(3).dgn Symbols 2 FLH_Standard_PDF
C. Typical Sectio ( A General STE(LAMRIFTNP.dgn  Alibates FLH_Standard_POF
D. Plan-Profile A General STE(LAMR)FTNP.dgn  Blue West FLH_Standard_PDF
E. Approaches A General STELAMRIETNE don ™ Eritch Foriress FLH Standard POF
> F. Soil Erosion § A General STE(LAMR)FTNP.dgn  Harbor Bay FLH_Standard_PDF
A General STE(LAMR)FTMNP.dgn Sanford Yake FLH_Standard_PDF
Select a Sheet(s) and |Acener Vicinity Map FLH_Standard_PDF

FLH_Standard_PDF
FLH_Standard_PDF

button

C.Typicy a5 Properties x
: —p— D. Plan-F
X-Sections @D2 D.Planf  main
D3 D Planf
{fE1  E Appro ]
@E2 E Appro Filename: |::\Users\brendan\Desktop\NEW ORD CAD Files\CFL DGNs\STE(LAMR)FTNP.dgn
ﬁ F1 F.SollE Model: |Fritch Fortress v
@F2 F.SolE
@M G1 G Drgi Print style: | FLH_Standard_PDF w
ffG2 Ggfrain
< > |«
The ONLY useful Property
setting that can be changed —
. - nce
is the Print Style.
ﬂ Harpers Corner Road.pset - Print Organizer — X

Tools I

Print Style
FLH_Standard_PDF

Convert to fixed print definitions

FLH_Standard_PDF
FLH_Standard_PDF
FLH_Standard_PDF
FLH_Standard_PDF
FLH_Standard_FPDF
FLH_Standard_PDF
FLH_Standard_PDF

File Edit View
LI ,:r—_—1:_ I'_Q] QQ Define Print Styles -%-% | &a
+ — — Apply Print Style... —
Y Harpers Corner Road . . S Model
- | | Convert to fixed print definitions
. ET = dgl"l Symbols1
ummary of Quantities @A2 A Ge
¥ Typical Section @A3 A Gene Use the
. Plan-Profile @A4 A Genera
. Approaches and Turnouts @A5 A General tool
T SedimentC| iz A6 A General STE(LAM - :
A7 A General STE(LAMR)FTNP.dgn Sanford Yake
- . . cinity Map
Select (highlight) the desired sheets. bad Typical Secti.
pad Typical Secti...
emiod 1N this case, the Parent Folder is selected, 3””19‘[3;2”959‘8”"-
- - an eg
X-Sect so the tool is applied to all sheets. an2 [Sheef
< > H <

>

= FLH_Standard_PDF.pltcfg | 41 items (0 selected)
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As shown below, after the Convert to fixed Print definitions tool is used, the full array of Properties
settings is available for manipulation.

D.1 Properties H

Main  Advanced Fence Display Levels References

Filename: |C:RUsers\brendan\Desktcp\NEW ORD CAD Files\Glenn Highway\glen_hwy_PLN_PP.dgn

Area Paper
Print area: |Fence w Papersize: |ANSIB "
Model: | ALI-Plan 1 [Sheet] ~ Limits: 17.000x 11.000 in
View group: | ALI-Plan 1 [Sheet] Views w Orientation: | Landscape ~
View: |View 1 v
[] Rasterized
Layout
Units: |in ~

Scale: |0.0833:1.0000 |

Size: |17.(}0[]' | |11.(}O[]' | i‘ Generating preview graphics

TIP: To remove the Pen Table %"
for Color Printing, highlight
and delete the File Path.

Refresh Show design overview

Resymbolization

Pen table:

Design script: | |

oK Cancel
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19C - SINGLE SHEET PRINTING

Single Sheet Printing is accomplished with the Print icon = located in the ORD Software title bar.
EJ OpenRoads Modeling v M T H |Il !_ (=] .* ¥ F\B955 (Mod 3) Granite Entrance Station Pre-
Home Terrain Geometry Site ors Moq print (Ctrl +P) duction Drawing An
& [om Pri nt iCO n Print to a printer or to a file & u ::
@0 <[z L8 e (i o Lgp | St g
Attributes Primary Selection

19C.1 Printing a Sheet Model

When printing from Sheet Model [ J, do NOT change any print settings. All print settings are pre-
configured by the FLH WorkSpace.

EXCEPTION: For color prints, the FLH Pen Table (“Black.tbl”) must be removed. To remove the
Pen Table, click the 3 button, as shown in the graphic below. For more information on color
prints, see 19E - Color Printing Workflow.

NOTE: Elements on the AUX_01 — AUX_10 Levels are ignored by the Pen Table. By default, the AUX
Levels will print in the same color as shown in the ORD Software, unless manipulated. Use the Level
Manager to manipulate the Color symbology of AUX Level to the desired printing color. See 19D - The
FLH Pen Table, Custom Levels, and AUX Levels.

ﬂ OpenRoads Modeling v M~ =] lT' f
Al o Select the
= [None Print icon

=l * = FAB955 (Mod 3) Granite Entrance Station Pre-

Mod print (Ctrl+P) duction Drawing An O pen the de5| I'Ed
Q Print to a printer or to a file (I Sheet Model [E
B ~ @& e

@o -[Zo __ LEMIL o S R R I
Attributes Primary Selection
—venr ez Sheet Model [3 == s
CE é /@ /em == o o[ & Print (FLH_Standard_PDF pltcfg) - X
File Settings Resymbolization

=R E S E s

Printer and Paper Size

s 1 should be set to | "¢y Adobe PDF - ..
----- : "AdObE_PDF" Bentley PDF printer driver
- e ANSI B -

The Paper Size and Orientation
is automatically set by the size of
the Page Border in the Sheet

Usable area is 17 x 11 in.

Landscape =

Model
:F Area: | Fence hd I:‘ Rasterized
WARNING: The Color setting must be set True Yew Miew .
Color for the FLH Pen Table to function Color: | True Color '| Copies: |1 Show design in preview p
correctly. Do NOT change this setting. -
' Scale: | 008333332 < Scale, Size, and Origin
Size: | 17.000 11.000 in. \i] Maximize s aUtOprTa'IZZCgu}'/-dsz:i by the

Origin: | 0.000 0.000 in. Auto-center

COLOR PRINTS ONLY: M

Design script:

Y &

4 Press Print to File -
to create the PDF.

To print in color, remove the Pen
Table. Clickthe  3{tton.
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19C.2 Printing from the 2D Design Model with a Fence

In legacy forms of the software, such as GEOPAK or OpenRoads SS4, printing was performed from 2D

Design Models 2 (this is because Sheet Models [2 were yet to be invented). In this workflow, a legacy
detail is printed.

To specify the exact area of the 2D Design Model 21 to be printed, a Fence must be placed. Legacy Files
contain a Plot Shape which represents the Page Border. Use the Place Fence tool with the Fence Type set
to Element to select the Plot Shape area for printing.

o From the Ribbon, select the Place Fence tool: [OpenRoads Modeling > Home - Selection].
o In the Place Fence dialogue box, set the Fence Type to Element.

o Left-Click on the Plot Shape/Page Border to set the active Fence.

= . S
‘J OpenRoads Modeling v VG Y H l:-l I ;“' — | .‘ ¥ CA\Users\brendan\Desktop\NEW ORD CAD
Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Annotate

e r===n ]

# None * | D_Dimensions M * = I % ¢ ’ =

kaasd pEE ] et L. '
E =) =3 ~|@o ~|o ~ Element Fence Reports Civil Corridor  pynamic
E - = Selection Toolsv &) ~ v Analysis ™ Reports ™ pjan View

Attributes [ | Place Fence % ilysis and Reporting

i Modify F

B View 1, USC ody Fence ZI@

f" Place Fence - X o i
“si  Manipulate Fence Contents
1 ® 00

—JEw
o~ Gl ~

FET— Delete Fence Contents

Fence Mode: | Inside 1 Drop Fence Contents

Save Fence to File

Named Boundaries

Plot Shape represents
the Page Border limits.

The Active Fence

should be set upon the
Plot Shape

The inside of the Plot Shape
will be shown in Green when
the Active Fence is set.
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WARNING: In the Print dialogue, it is possible that the Print Preview is displaying the wrong area.
To display the correct area, change the Area to View and then change it back to Fence. Examine the
Print Preview to ensure the correct area is displayed.

EJ OpenRoads Modeling v BT k4 "l

Home Terrain Geometry Site
Select the
Print icon

=l .‘ ¥ CA\Users\brendan\Desktop\NE\

Corridors Mocﬁl Detailing Drawing Production Drawing An

I ——
N PR R
2 E@ve - YO B
diir=} S
H i
g Lemad

v 85 [

Z |None

. - » | Explorer Attach = Element Fence
[ o 00 . Tools* &5 ~ %'~ Selection Tools~ W ~
—
Primary Selection

H View 1, USC E@
EE"(jl{+}' é?}cj}jiégﬁj;’)i!! == EE(QECE:

&4 Print (FLH_Standard_PDF pltcfg)

File Settings Resymbolization
i ¥
" -
= Q[ 2 & ‘

Printer and Paper Size

¢ Adobe_PDF v

Bentley PDF printer driver

ANSI B i

Usable area is 17 x 11 in.

Landscape i

E— - I - i e

View 1 -

IMPORTANT: The Area should be set to
Color: | True Color ~ Copies: |1 [#/]{ Fence. However, this may have to be reset
to reflect the Active Fence area.
Scale: | 100.0000 .
N To reset, change the Area to View and

Size: | 17.000 11.000 in (] Maximize then back to Fence. Examine the Preview
Origin: | 0.000 0.000 - Al to ensure the Active Fence area is shown.

X E
Pen table: | Black:tbl e K

Design script:

n Print to File... |

Select Print to File to specify the
file location and print the PDF.
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19D - THE FLH PEN TABLE, CUSTOM LEVELS, AND AUX LEVELS

A Pen Table works by reading the Level assigned to a geometrical or annotation element. In the
background printing process, the Pen Table manipulates the element’s Color for appropriate display in the

printed PDF.

For plan set printing, FLH has a default Pen Table, which is named “Black.tbl”. This Pen Table is used for
black, white, and grey-scale printing. The following CONCEPTS explain how the FLH Pen Table functions:

CONCEPT 1: The FLH Pen Table (“Black.tbl) is automatically applied in the Print Properties. For
conventional black and white printing, it is NOT necessary to manually apply the FLH Pen Table before

printing.

CONCEPT 2: The FLH Pen Table is designed to work with True Color print setting. The True Color
option is set by default and should NOT be changed. With this setting, Levels that are NOT recognized by
the FLH Pen Table are printed in the color shown in the ORD Software. Similarly, if the FLH Pen Table is
removed, then ALL Levels will print in the color shown in the Sheet Model L.

Design script:

Ej Print (FLH_Standard_PDF.pltcfg) *
File Settings Resymbolization
5= ¥
= Q[ E D E ‘
Printer and Paper Size e B
[ ¢s Adobe_PDF h
Bentley PDF printer driver
ANSI B h | =
Usable area is 17 x 11 in. '
Landscape 7 '
Area: | Fence e F : ‘"""""
- CONCEPT 2
View: |[View 1 ~
ICoIor' True Color h True COIOr design i i 1
: . . v design in preview
print setting = a
Scale: | 0.08333317 Rotation: v
Size: | 17.000 11.000 in. |J Maximize
ongis oo (oo 1m |  CONCEPT 1
FLH Pen Table is
Pen table: | Black.tbl . . ) y ) 4
E automatically applied.

TIP: For Color Prints, press
the X button to remove the
FLH Pen Table.
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CONCEPT 3: The FLH Pen Table reads the Prefix in the Level Name. The Level Name Prefix

determines the Level’s color in the printed PDF:

Existing Levels (E_...): Levels that begin with an “E_...." prefix will print in a shade of grey.

For example, the “E_PLM_Sidewalk” Level will print in grey.

Proposed Levels (P_...): Levels that begin with a “P_...." prefix will print in black. For

example, the “"P_HYD_Ditch” Level will print in black.

 Level Display - Vie.. — X
Ell'—.l_'l :_‘ View Display A
\Eé E’E ?(none} ¥ |Levels = Ilﬁ hd
Example File.dgn

o P -
E_PLM_RR_Ballast_Points

E_PLM_RR_Railroad_Points

E PLM_RR_Railroad_Tracks CO N C E PT 3

E_PLM_RR_Top_Rai Existing Levels contain
E_PLM_Sidewalk an "E_" Prefix and are

E_PLM_Sidewalk_Points ; .
E_PLM_Sign_Message prlntEd n Grev'

E_PLM_Sign_Points
E_PLM_Signs

P_Custom Level CONCEPT 3
P_HYD_Data_Profile Proposed Levels
S contain an "P_" Prefix

P_HYD_Ditch_Center_Line
P HYD Ditch_Paved

and are printed in Black.

P_HYD_Energy_Dissipaters v

CONCEPT 4: Occasionally, a Custom Level must be created to accurately describe an atypical design
feature. A Custom Level needs to be named with the appropriate Prefix to be recognized by the FLH

Pen Table.

For example, a Custom Level that is named “P_Log Fence” would be recognized by the FLH Pen
Table and printed in black.
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CONCEPT 5: If a Custom Levels is NOT recognized by the FLH Pen Table, then it will be printed in the same color shown in the ORD
Software.
For example, a Custom Level that is named “Log Fence” would NOT be recognized by the FLH Pen Table and would print according to
the Color Symbology set in the Level Manager .

CONCEPT 4

7a: Level Manager The "P_Log Fence" Level will print
in Black because the "P_" prefix is
recognized by the FLH Pen Table.

@ ?_‘;g Used ™ &

3 P _Fence 0 .
]
E ; " Level

Levels Filter Edit
"‘ﬁ Symbology:  Bylevel = ‘ ?{n e) ¥ ‘ Iﬁ - ‘ %E] ‘Xi

=02 |Fvnmn'a£i.l.ada.n.|J.|_A

Custom Levels
(created by the User)

o]

Il 50 Color Symbology
] 222 0 1
=
CONCEPT 5

P_WAL_Soil ]

The "Log Fence" Level will print in Red
because this Custom Level is NOT
recognized by the FLH Pen Table.

Active Level: P WAL SMSE 1050 of 1051 OmSpTaye T sereeen, |

P_WAL_Seeding

BEST PRACTICE: When creating a Custom Level, either name it with an appropriate Prefix (i.e., E_ or P_) or set the Color Symbology to
the desired printing color.
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CONCEPT 6: The AUX_01 - AUX_10 Levels are intended for custom printing applications. By design, AUX Levels are NOT recognized
by the FLH Pen Table. The AUX Levels will print according to their set Color Symbology. When using the AUX Level, override the Color

Symbology to the desired printing color.

For example, the default Color Symbology for the AUX_01 Level is blue. In the printed PDF, elements assigned to the AUX_10 Level
will be blue - unless the Level is overridden in the Level Manager .

%5 Level Manager _ %
Levels Filter Edit CONCEPT 6
-1-25_; Symbology: | Bylevel 7 ?(none)' [ﬂ ~ ég
A Name © 2 1 The AUX Levels are printed according
S All Levels AUX 01 W i to the set Color Symbology.
Y Filters AUX_02 N E‘L By default, elements assigned to the
AUX 03 EE 1 AUX_01 Level will print in Blue.
AUX_04 4 - —
AU 05 W ] Change the Color Symbology of the
AUX Levels § Os - AUX Levels to the
AUX_07 g - desired printing color.
AUX_08 ! —0 1
AUX_09 D 0 1
AUX_10 [J 10 0 1
N Clinnina Shane Mo - 5 n v
Active Level: E.GEO_DTM_Triangle_Vertices 1050 of 1052 displayed; 1 selected;

IMPORTANT: When using AUX Levels, change the default Color Symbology to the desired printing color.

TIP: Use the Color 0 to print elements on the AUX Level in Black.

TIP: For exhibits and other color prints, create elements to be shown in color on the AUX Levels. Change the Color Symbology of the

AUX Level to the desired printing color.
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CONCEPT 7: To print Custom Levels and AUX Levels in Black, set the Color Symbology to Color 0.

Although this color appears as white in the color palate, Level’s assigned to this Color 0 will print

in Black.

WARNING: The color E will NOT print in black. This color mimics the Background Color of the

sheet. Levels assigned to this color will NOT be visible in the printed PDF.

CONCEPT 8: To print Custom Levels and AUX Levels in Grey, use the colors shown below.

CONCEPT 7
Color 0

This Color appears as White here,
but elements assigned to this
color are actually printed in Black.

WARNING: This color is NOT Black.
This color will mimic the Background
- which is typically White.

Levels assigned to this color will NOT
be visible in the printed PDF.

RGE: 255, 255, 255

Cancel

CONCEPT 9: Color Symbology for Custom Levels or AUX Levels are initially set in the original Design
ORD File. However, the Color Symbology can be overridden within an individual Plan Sheet ORD

File.

Design ORD File: The Color Symbology set in the Design ORD File will carry over to all Plan
Sheet ORD Files. Setting the desired Color Symbology in the Design ORD File ensures that
the Level is printed in the desired color for all sheets in the plan set. BEST PRACTICE: For

Custom Levels and AUX Levels, set the desired in the Design ORD File.

Plan Sheet ORD File (color override): The Color Symbology can be overridden for an
individual Plan Sheet ORD File. An override could be used to show a Custom Level or AUX Level
differently for an individual sheet. The override process is commonly used to create custom Color
Prints. The process for overriding a Level’s Color Symbology is shown in 19E - Color Printing

Workflow.

NOTE: If the FLH Pen Table is applied and a Level is recognized, then the Color Symbology is
inconsequential. Color Symbology overrides ONLY take affect if NO Pen Table is applied or the

Level is unrecognized by the Pen Table.
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19E — COLOR PRINTING WORKFLOW

This section demonstrates how to print exhibits and other miscellaneous sheets in color.

IMPORTANT: Before continuing, review the CONCEPTS presented in 19D - The FLH Pen Table, Custom
Levels, and AUX Levels.

There are two main processes for creating color prints:

e Override the Color Symbology for ALL Levels referenced into the Plan Sheet ORD File. In
the Level Manager, change the Color Symbology for all Levels. Since the FLH Pen Table is NOT
used, the colors in the printed PDF will exactly reflect the colors shown in the Sheet Model [2.

¢ Remove the FLH Pen Table before printing.
WARNING: Color Symbology overrides through the Level Manager & have no effect on elements that

have been overridden through the Properties @1 box. For example, if an element’s color is NOT set to By
Level, then overriding Color Symbology through the Level Manager % is inconsequential.

NOTICE: The Color and Fill for

@] Properties - *

this element has been changed.

4 f{: Elements (1)

g vewnos

b ¢ ltems

If unaltered, the Color and Fill
will be set to ByLevel (0).

General ~

Element Description Shape
| evel Wetlands

6 |
Line Style %_ByLevel ]

Weight BylLevel (0)
Class Pomary

Fill s |
Template Tnane}
Transparency 50

Priority -100

At b,

‘-— B S a9 - £ i,
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o Create a new Plan Sheet ORD File. See 3B = Create a New. ORD File.

In the new Plan Sheet ORD File, reference in all required Design ORD Files and Existing Survey
ORD Files.

o Create a Sheet Model [3 for the color print. See Chapter 14 - Plan Sheet Production.
IMPORTANT: Return to the 2D Design Model 21 of the Plan Sheet ORD File.

o Open the Level Manager ..
[OpenRoads Modeling > Home - Primary]

E‘] OpenRoads Modeling v | VB T ki LN @ — | .' '*.'ﬁ_@ T T

Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Uti

- - oo .
= Mone ™ | Default - q 9 * ]
| Sppp—_—

LN =

v || = v || = v || v |, v Explorer Attach Element Fence
’:! 0 0 — 0 - 0 . 0 ols * :‘,.._ hd ¥ Selection Tools = . =
Attributes »5. Level Manager zlection

%5 Level Manager Flyout

B View 1, Design IntIFt BEFORE =B S
G~ Clig-~ 1l ® 0

hd

Color Symbology Overrides

(I
.......
_____

IMPORTANT: Return to the
2D Design Model '] before |
opening the Level Manager. §

o
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o In the Level Manager %, set each Level to the desired Color Symbology for the printed PDF.

?:_:i Level Manager

|
TIP: Sort Levels

TIP: Select (highlight)
a Reference File or
select All Levels.

Levels Filter Edit by Used
Symbology: | Bylevel = ?{none}l' M - a‘% x Color Symbologv ‘
=-\v8]id-a2158061_pin_color exhibitdgn | | A Name [ Used * *
Reference V8 id-a2158061_sur.dgn Default 0 e |
Files id-a2158061_cor.dgn, Default XS_TL_Fill 3 .
: Wetland Delineation.dgn X5_TL Edge of Pavt 0 .
= All Levels X5_TL Cut 3 .
Y Fiters :-::ssjtecr 20 2 i
5-OBJECT-14 Override (change) the

P_TC_Signs_Permanent
P_TC Object_Markers
P_HAL Stations - Small Scal

D HAI Céatianes

Color Symbology for
ALL Levels.

-] ¥

Active TEVeT DeTau

46 of 46 displayed; 1 selecteq;

ource: id-a2158061_pln_color exhibit.dgn”

TIP: Select (highlight) a Reference File to ONLY view Levels contained in that Reference File. Select All Levels to view every Level referenced

in the current ORD File.

TIP: Sort the Level Manager list by the Used column. If a Level is utilized in an ORD File, then a dot will appear next to the Level in the

Used column.
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AFTER

B View 1, Design IntlFt

E v I::Iv-":': v l /@ /e

Color Symbol gy Overrides ol S
Y9 S P oy e R

PI 92+93.60

A = 23°38'41" (LT)
R = 210.00'

T = 43.96'

L = 86.66'

After performing Color Symbology overrides, proceed with the printing process. IMPORTANT: Remove
the FLH Pen Table before printing.

Color Printing from the Sheet Model [3: Printing from the Sheet Model [2 is demonstrated in 19C.1
Printing a Sheet. Step 3 in that workflow shows how to remove the FLH Pen Table when printing from a
Sheet Model [2.

Color Printing from the Print Organizer and Print Set Files (.pset): To remove the FLH Pen Table
from a sheet in a Print Set File (.pset), see 19A.6 Print Properties, the FLH Pen Table, and Color Prints.

Color Printing from the Sheet Index: To remove the FLH Pen Table from sheets generated by the
Sheet Index, first the process shown in 19B.3 Enable Print Properties Settings must be performed. Then
remove the FLH Pen Table as shown in 19A.6 Print Properties, the FLH Pen Table, and Color Prints.
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19F — MISCELLANEOUS PRINTING WORKFLOWS
19F.1 Roll Plots

Roll Plots are printed from large plotter paper rolls and intended to show long stretches of roadways.
Plotter paper rolls come in a variety of widths. The most common plotter paper widths are 22-inch, 34-
inch, 36-inch, 40-inch, and 42-inch.

This workflow shows how to create a roll plot for 34-inch wide paper. However, this workflow could be
applied to other common plotter paper sizes.

In the 2D Design Model QJ, a Plot Shape element must be manually drawn for each sheet in the Roll Plot.

WFL Users: Current in-house plotter can print 22-inch wide and 34-inch wide. All other sizes will
have to printed offsite

19F.1.a Determine the Plot Shape Dimensions
The dimensions of the user-created Plot Shape element depend on two factors:

Plotter Paper Width Size: Before continuing with this workflow, confirm the paper width
capability of the plotter that will be used for printing. The plotter paper width will determine the
REQUIRED Plot Shape Width.

Design Scale for the Roll Plot sheets: The Roll Plots should be created at a conventional Design
Scale (i.e., 1"=40") so that scaled measurements can be made with rulers on the printed Roll Plot
sheet. If unsure of an appropriate Design Scale, start with 1”=40" or 1"=50".

Use the chart below to determine the dimensions of the Plot Shape based on the selected Design Scale
and appropriate plotter paper width:

Plot Shape Dimensions for Common Paper Sizes and Design Scales

Maximum
Paper Paper Paper Paper Length*
1" =10’ 340 feet 360 feet 400 feet 420 feet 2,000 feet
1" = 20’ 680 feet 720 feet 800 feet 840 feet 4,000 feet
1" = 30’ 1,020 feet 1,080 feet 1,200 feet 1,260 feet 6,000 feet
1” = 40’ 1,360 feet 1,440 feet 1,600 feet 1,680 feet 8,000 feet
1" =50’ 1,700 feet 1,800 feet 2,000 feet 2,100 feet 10,000 feet
1” = 60’ 2,040 feet 2,160 feet 2,400 feet 2,520 feet 12,000 feet
1" = 80’ 2,720 feet 2,880 feet 3,200 feet 3,360 feet 16,000 feet
1” =100’ 3,400 feet 3,600 feet 4,000 feet 4,200 feet 20,000 feet

IMPORTANT*: The Length of each Plot Shape depends on curves and meanders in the road alignment.
However, do NOT exceed the maximum length shown in the chart.
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In this example, a 34-Inch Roll Plot Width and 1” =50’ Design Scale is used. This configuration
necessitates a REQUIRED Plot Shape Width of 1,700 feet and a Maximum Plot Shape Length of
10,000 feet.

19F.1.b Draw and Position the Plot Shapes in the 2D Designh Model %

Using the Place Block tool, draw the Plot Shape element to the dimensions determined from the chart on
the previous page.

TIP: Assign the custom Plot Shape to the “D_Plot_Shape” Level. This Level is configured to NOT print.

©

o . = \ \ P T
k4 OpenRoadsModeling ~ (8 T [B « ~ » # & K D' Q@ & G E & @ £ = C\Users\brendan\Desktop\NEW ORD CAD Fil
Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Annotate Utilities Collabol

From the Ribbon, select the Place Block tool:
[OpenRoads Modeling > Drawing -> Placement].

@ [None 1 o_Piot shape . (&) (¥ i'""i X /% Place Smartline O v 4 + %+ S Move =i 58
— — ot ;;;e /" Place Line v & ~ o7 Copy AN I
B: -lB0 -||=1 ~/W0 -jlA0 - SEeIFengti ® Tools~ )~/ ArcT [] Place Block N &R
TIP: Set the Active Level to Selection lacel 2 place Shape pulate

"D_Plot_Shape" to ensure the
Plot Shape does NOT print.

% Place Orthogonal Shape

@ Place Regular Polygon

Draw the custom Plot Shape using the appropriate dimensions. In this case (34-inch wide paper size and
1”=50 design scale), the REQUIRED Plot Shape Width is 1,700 feet and the Maximum Plot Shape
Length is 10,000 feet. However, the Plot Shape length can be adjusted as needed.

e

lK.IViewLDEfaUI't | AccuDraw n
- On- s PLPCODES SX x|

Plot Shape TIP: Use AccuDraw
to lock the
Y-Dimension (width)
of the Plot Shape.

1,700 feet

The Length of the initial
Plot Shape is NOT friaceBlock — %
important.
Method: | Orthogonal ~ ~ |
The Length of each Plot
Shape will be adjusted for Area: |Solid v

project requirements. Bl Type: Nmei,

Fill Color: | 3 -
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Next, the Plot Shape is Moved, Rotated, and the Length is adjusted to fit the project roadway.

Move and Rotate
the Plot Shape into
the desired position.

Adjust the Length
of the Plot Shape to
project conditions.

WARNING: Do NOT alter the
Width of the Plot Shape,
when adjusting the Length.

Copy the initial Plot Shape element and position/adjust the copied Plot Shape to encompass the desired
print area. Repeat this process for the remainder of the project.

b g ﬂ
- clw-|L P PPCOD EF S X

Plot Shapes assembled
into final position.

19-39



19F.1.c Roll Plot Printing Procedure

Each Plot Shape is individually printed directly from the 2D Design Model Q,

IMPORTANT: The following procedure must be performed for each Plot Shape.

Use the Rotate View tool "'"J to orientate the View with Plot Shape. The View must be parallel
with the Plot Shape for the resulting print to be positioned correctly.

Use the 2 Points method and select 2 points on the top-edge of the Plot Shape.

1 SR Wikas o SB‘EE\:'E':&@:

Rotate View !i.
T Rotate view Jii
Rotate View tool

4’[5._«2 Rotate View o >

! Method:: | 2 Points

Select 2 Points on the top
edge of the Plot Shape to
rotate the View.
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To designate the area to be printed, an Active Fence must be placed atop the Plot Shape.
Use the Place Fence tool with the Element Fence Type. Select the Plot Shape as the
Element.

-----

a OpenRoads Modeling IR ™ | 7 S RNEAA =N S & ® 3 s C\Users\brendan\Desktop\NEV

Home Terrain Geometry Site Corrido Madel Detailing Drawing Production Drawing Annotate Utilitie:
' . [ - ~ ORI ‘ :
#. None v | D_Plot_Shape bt | ool = * : i 4 % Place SmartLi

el = — a , Select the /" Place Line

23 Ym0 Y IES5 ~ 0 v|4&o B . ) .
Place Fence tool N~/ ArcTools
Autributes PHALY Place Fence N
@ 4 PlaceFence  — X Modify Fence

Manipulate Fence Contents

Delete Fence Contents

Fence Mode:

Drop Fence Contents

Save Fence to File

Named Boundaries

Select (Left-Click)
on the Plot Shape to
set an Active Fence.

The inside of the Plot Shape
will be shown in Green when
the Active Fence is set.

19-41



In the following steps, the Print dialogue box is configured.

IMPORTANT: The Paper Size (shown in Step ) must correspond to the plotter paper width.

WARNING: The FLH WorkSpace does NOT contain pre-created Paper Sizes for 36-inch, 40-inch,
and 42-inch prints. Create a custom Paper Size for these widths using the procedure shown in
19F.3 Create a Custom Paper Size. Regardless of the plotter paper width, the length should be set
to 200-inches. For example, if creating a custom Paper Size for a 40-inch print, set the Width to
40-inches and the Length to 200-inches.

IMPORTANT: It may be necessary to reset the Area. If the preview shows an incorrect area, then
change the Area to View and then change it back to Fence. See Step ﬂ

EJ OpenRoads Modeling v Mg v & H |1'f !-;,'- .- v f ..EJ s

Home Terrain Geometry Site Corridaors

g Drawing Production Drawing An

i Select the Print & icon.

|| = v || = v " v | Explorer Attate=—— TETTTET reEE
’ B0 "S5 "[Mo "fAo PO Toolsw @ v T v Selection ‘@ Toolsv I~

% None ¥ | D_Plot_Shape v

Attributes Primary Selection

U Print (FLH_Standard_PDF.pltcfg) X

Use the Apply Print Style
button to set the Print Style
to "FLH_Standard_PDF".

File Settings Resymbalization
. 8T [ [
= & E

L3
Printer and Paper Size S

=g Adobe_PDF

Change the Paper
Size to "Long-34"
.'.-..:__ 6

IMPORTANT: The Area should be set to
Fence. However, this has to be reset to
reflect the correct Scale and Print Preview.

— - I%
View: |View 1 v Change the Area to View and then back to

Fence to reset the Scale and Print Preview.

Bentley PDF printer driver

Long-34

Usable area is 200 x 34 in.

Landscape ~

Color: | True Color e Copies: | 1 Sh
‘/- IMPORTANT: If the Width of the Plot

Scale: | 50.00000 Shape was drawn to the correct dimensions,

size: | 111853 | 34000  |in ] Maximize then the Scale should NOT have to be
manually altered.
Origin: | 0.000 0.000 in. Auto-center
IPentabIe: Color.tbl / X
Design script: w»
Print the

Print to File...

Set the appropriate Pen Table.

Roll Plot

Typically, Roll Plots use the
"Color.tbl" Pen Table.

Repeat Steps 1-8 for the remaining Plot Shapes.
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19F.2 Georeferenced Printing for Avenza

This section demonstrates how to create georeferenced PDFs for use with the Avenza mapping software.

A georeferenced can be created from a Sheet Models [2 or from the 2D Design Model .

Sheet Model [3: A set of geo-referenced PDFs created from Sheet Models [2 can be loaded into
Avenza. This method is beneficial because the Profile design and plan annotations can be viewed
within the Avenza software. See 19F.2.a Print a Georeferenced PDF from a Sheet Model and
19F.2.b Batch Printing Georeferenced PDFs from the Print Organizer.

2D Design Model 2: From the 2D Design Model QJ, the entire project limits can be captured in
a single georeferenced PDF. See 19F.C Print a Large Area Georeferenced PDF from the 2D Design
Model.

Whether printing from the Sheet Model [2 or the 2D Design Model QJ, the following requirements must
be fulfilled:

A coordinate system must be set in the 2D Design Model 21 of the ORD File. Setting the
coordinate system of a 2D Design Model 1 is shown in 3D.1 Set the Coordinate System.

In the Print Properties, the Paper Size must be set to Avenza. Using conventional Paper Sizes (i.e.
ANSI B) results in a georeferenced PDF with poor resolution.

To load correctly in Avenza, a georeferenced PDF must ONLY contain a single page. Multiple PDFs
can be loaded into Avenza. However, each PDF must contain a single page. Avenza does NOT
recognize PDFs with multiple pages. To print a set of single page PDFs, see 19F.2.b Batch Printing
Georeferenced PDFs from the Print Organizer.

WARNING: Plan-Plan Sheets CANNOT be loaded into Avenza because two plan maps are shown
per page. Only sheets that show a single plan map (i.e., Plan and Profile Sheets, Plan Sheets)
should be loaded into Avenza.

TIP: To verify if a PDF is georeferenced, open the PDF in Adobe. Enable the Measure ribbon and select
the Geospatial Location Tool. Hover the mouse cursor in the plan view area and observe the Latitude and
Longitude in the lower-right corner. The Latitude and Longitude value at a given point can be searched in
Avenza, Google Earth, or Google Maps to verify the PDF is georeferenced to the correct project location.
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19F.2.a Print a Georeferenced PDF from a Sheet Model

Any Sheet Model @, including Plan and Profile sheets, can be printed as a georeferenced PDF and loaded
into Avenza.

WARNING: Before attempting to print georeferenced PDFs, ensure that a coordinate system is set in the
2D Design Model 2. see

In this workflow, a georeferenced PDF is created from a Sheet Model L.

ﬁ OpenRoads Modeling v VBT H l'r' !-;,'- L f ..EJ s

Home Terrain Geometry Site Corridors

g Drawing Production Drawing An

& |None *  D_Plot Shape . Select the Print & icone.'Je
] |5 v|=s5 ~ v |[A v || Expl AttaCrr— ToTTTE y .
E: 2 0 =>5 Qo =0 PO Toolsw %+ %+ selection & Tools> W) ~
Attributes Primary Selection
— View 1, ALL_MAIN_Riverside - Plan 1 [Sheet] = =R %"
Chl PO /@sﬁE*ngf e
Open a Sheet Model [ &
& = —
A Lo o
® e B l_ U he Apblv Print Stvl
&) Print (FLH_Standard_PDF pitcfq) se the Apply Print Style |
- N button to set the Print Style
t t
File Settings Resym :J ization to "FLH_Standard_PDF".
Sy B HE K " :
- T |
Printer and Paper Size — '
[ ¢ Adobe_PDF Change the Paper Size
. n n
Bentley PDF printer driver to "Avenza
Avenza 1f%@%i
| A e
: ANSIE
ez .| |ANSID
. ANSI C
ANSI B by
ANSI A
Long-22
g | Long—34 ) i ]
Avenza . Show design in preview é .
Scale: | 0.08333317 Rotation: | None v
Size: | 17.000 1 Set the a Pen Table.
Origin: | 0.000 in. Auto-center
| Pen table: | Blacktbl 4 XI
Design script: p~ 4
Print the PDF
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19F.2.b Batch Printing Georeferenced PDFs from the Print Organizer

In this workflow, a set of Sheet Models [2 are batch printed from the Print Organizer into separated

georeferenced PDFs.

o

IMPORTANT: When printing, change the Submit As setting to Separate Print Jobs, as shown

in step &)

In the Print Organizer, create and populate a new Print Set File (.pset). See 19A - Plan Set

Printing (Batch Printing).

IMPORTANT: When adding sheets to the Print Organizer, ensure that the “FLH_Standard_PDF”
Print Style is applied. See 19A.5 Add Sheets to the Print Set File (.pset).

Select (highlight) all sheets in the Print Organizer and select Properties @:l button.

In the Properties set the Paper Size to Avenza.

Color Prints: To print the Roll Plot sheets in color, remove FLH Pen Table.

ﬂ Untitled.pset - Print Organizer

TIP: Push CTRL + A to

File Edit View Tools
= — select (highlight) all sheets.
51l 29095 ANV Y

i me - Folder File Name Maodel View Group

([ id-a2158061_pin_pp { id-a2158061 LOPFHISS id-a2158061_pln_pp.dgn  AL_MAIN_Riversi.. AL|MAIN_F

. . ‘.fid-32158(}61_p\n_pp id-a2158061_pIn_pp.dgn  ALI_MAIN_Riversi..  ALI_MAIN_F

Select (hlgh“ght) all [ id-a2158061_pin_pp id-a2158061_pin_pp.dgn  ALI_MAIN_Riversi.. AL_MAIN_F

Sheets and push the  ||FEEREIEEE e e

- id-a _pln_pp id-a _pln_pp.dgn || _Riversi... | ||

Properties @ button. {1id-a2158061 pin_pp ic 22158061 pin. pp.dgn ALL MAIN Biversi. . ALL MAIN_F

Madify Properties X

Main  Advanced Fence Display Levels References

Paper

nt area:

Set the Paper Size
to Avenza.

Orientation: | apg) A

ANSIB
ANSIC
ANSID
ANSIE
Arch A
Arch B
Arch C
ArchD
ArchE
Arch E1
IS0 AD

ISO A1 L\\’
1SO A2

IS0 A3

IS0 A4

Long-22

Long-34

Paper source:

View: v

[m] Rasterized [m] Print to 3D

Layout
Units: )

Size/Scale: ~

Rotation: | |

Origin: e

For Color Prints, delete
the Pen Table file path.

Resymbolization

I Pen table: |iration\Organization-CivilFLH_SurvFt_Standards-WS10.9.1V\Printing\Pen Tables\Black tbl

[] Clear in print definitions

Design script: | ‘

[] Clear in print definitions

OK Cancel
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Select (highlight) the Parent Folder and push the Print = button.

Set File (.pset).

Change the Submit As setting to Separate Print Jobs.

ﬂ This setting ensures that an individual georeferenced PDF is created for each sheet in the Print

IMPORTANT: To load correctly in Avenza, each georeferenced PDF must contain a single page.

Continue to Print the PDFs as shown in 19A.7 Printing the Print Set File (.pset).

Ej Avenza Batch Print.pset - Print Organizer

File Edit View Tools

Name
o 1d-a2158061_1 print

J id-a2153061_pl
J 1d-a2158061_pin_pp

Select (highlight) the
Parent Folder and push
the Print = button.

o id-a2158061_pin_pp
J id-a2158061_pin_pp

LS =X e A A v ¥ E-
- Auve ||.?..1Hl||.r|-|r|!

Faolder FI|E MName Madel

id-a2158061_pln_pp.dgn  ALI_MAIN_Riversi..
id-a2158061_pin_pp.dgn  ALI_MAIN_Riversi_.

".'i.ew Group
ALILMAIN_F
ALI_MAIM_F|

4 i4-a2158061_pln_pp 1 Print
J id-a2153061_pin_pp
J id-a2158061_pin_pp

Printer Setup..
| Print Range Copies
Oy A Number of copies: |1 5
ﬂ | (@) Selection
Submit
IMPORTANT: Creale prnt file
Change the Submit as to | Output File Nomes

Separate print jobs to
create a single PDF for each
sheet.

1 Printer Driver Configuration
Fllename: FLH_Standard_PDF pitcfg
Type: Bentley PDF primer driver

Dm:wm&m& directony for print destination

o] o

ORD CAD Files\Riverside\Untouchead) |

MN_F
X AN
N_F
N_F

)
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19F.2.c Print a Large Area Georeferenced PDF from the 2D Design Model
In this workflow, a single georeferenced PDF that encompasses the entire project limits is created.

WARNING: For longer projects, the Avenza Paper Size must be modified to sharpen the resolution of
the resulting georeferenced PDF. If the project is too large and the default Avenza Paper Size is used,
then the resulting georeferenced PDF will have poor resolution, making it difficult to identify design
elements. See 19F.2.c.iv Examine the Resolution of the PDF.

19F.2.c.i Create a Plot Shape in the 2D Design Model @

The Plot Shape for this workflow could be rectangular (use the Place Block tool) or an irregular enclosed
shape created with the Place Shape tool.

As shown below, it is recommended that an irregular shape that follows the project Alignment is created.
This helps to reduce the final PDF size because unnecessary aerial graphics are excluded from printing.

k4 OpenRoadsModeling ~ (8~ T HE T « - » £ 2 & D' @ = T B 5 € £3 5 C\Users\brendan\Desktop\NEW ORD CAD Fi
Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Annotate Utilities Collabol
@ [None + 1 b_Piot Shape - {E‘;} {:ﬂ:} E'""E b4 % Place SmartLine O~+ ~%~| FMove = 88
A S /" Place Line Clv A~ - Copy
E: =R MRS T A0~ SEe'Fe"Qti ] TEJ%T;E Q- _/ ArcToals = [] Place Block X
TIP: Set the Active Level to Selection (% Place Shape

=
T T E T T T O T

1 "D_Plot_Shape" to ensure the

g“\ Place onhogonal Shape

| Plot Shape does NOT print. () Plase Regular Paljgon

Project
Alignment

Plot Shape
created with the
Place Shape tool
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19F.2.c.ii Set a Fence around the Plot Shape

Select the Place Fence tool and change the Fence Type to Element. Select the Plot Shape created in the
previous procedure.

'-" i =1 3 ot - [F =
‘:J OpenRoads Modeling  ~ (@ & HE I « » » £ & K D' 1 = & B & 8 £3 5 c\Users\brendan\Desktop\NEW ORD CAD Files\CFL DC
Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Annotate Utilities Collaborate v

& [None = —— . E, v & v k {‘:} Y {"'} X /G Place Smartline O * 4+ ~» %f ~
. : 30 — = -BC AT - Select the . o - /IPIaceLme I‘:| v Ao
Place Fence tool ™ Toolsw I ~| ) ArcTools ~ NA-~
Attributes Primary {1 PlaceFence % icement

— ﬁ Place Fence = X Modify Fence

m i
@ -

i Change the Fence Type
= ] to Element

Manipulate Fence Contents

Efence Type: | Element W

Delete Fence Contents

Fence Mode: | Inside =

Drop Fence Contents
Save Fence to File

Named Boundaries

Select (Left-Click)
on the Plot Shape to
set an Active Fence.

The inside of the Plot Shape
will be shown in Green when
the Active Fence is set.
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19F.2.c.iii Print the Fence Area using the Avenza Paper Size
In the following steps, the Print dialogue box is configured.

IMPORTANT: Ensure the Paper Size is set to “Avenza”. See Step [E}.

IMPORTANT: It may be necessary to reset the Area. If the preview shows the incorrect area, then
change the Area to View and then back to Fence. See Step -

@ OpenRoads Modeling + W & - II: !-;;- *- v

Home Terrain Geometry Site Corridors

= : Select the Print & icon.

% None v | D_Plot_Shape v L F
Attach ~ T e S
v || = v |[= - v |[ A - ac - ence
E 3 =0 =5 g[} &0 er Tngls v &« 00 CEIFI‘QEHE o Tools» W ~
Attributes Use the Apply Print Style Ln

button to set the Print Style
to "FLH_Standard_PDF".

&4 Print (FLH_Standard_PDF.pltcfg)

File Settings Resymbolization
BYHEDE

Printer and Paper Size
¢ Adobe_PDF

Change the Paper Size
to "Avenza"

Bentley PDF printer driver

I Avenza

Usable area is 100 x 50 in.

Landscape ~

IMPORTANT: The Area should be set to
Fence. However, this may have to be reset to
reflect the Active Fence area.

Set the appropriate Pen Table. Change the Area to View and then back to
Fence. Examine the Preview to ensure the
Typically, Avenza PDFs use the Active Fence area is shown.
"Color.tbl" Pen Table.
Pen table: | Color.tbl . , x
Design script: ~N

Print the PDFH Print to File... |
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19F.2.c.iv Examine the Resolution of the PDF

In Adobe or Blue Beam, open the georeferenced PDF and zoom in on a project feature. If the aerial,
design elements, or annotations appear too coarse or “grainy”, then the Avenza Paper Size is inadequate
and a custom Paper Size must be created.

NOTE: The Avenza Paper Size is 200-inches by 100-inches.

To increase the resolution, create a custom Paper Size that is 400-inches by 200-inches. Re-print the
georeferenced PDF using the custom Paper Size. If the resolution is still too coarse, then create another
custom Paper size with larger dimensions. Repeat this process until adequate image resolution is
achieved.

The process of creating a custom Paper Size is shown in 19F.3 Create a Custom Paper Size.

19F.2.d Load Referenced PDFs into Avenza
For field reconnaissance, georeferenced PDFs are loaded on to iPads and imported in to Avenza.

The process of loading georeferenced PDFs onto an iPad is shown in a different tutorial document called:
“WFLHD iPad Tutorials.pdf”.
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19F.3 Create a Custom Paper Size
For miscellaneous printing workflows, it may be necessary to create a custom Paper Size.

IMPORTANT: Before a custom Paper Size can be created, perform a Save As of the default Printer
Configuration File (shown below). Do NOT directly edit the default Printer Configuration File.

Place the Save As copy on the local C:/ Drive.

KJ OpenRoads Modeling v Mg~ H I[' !.'

a0 Select the

-.‘=‘J h‘ ¥ F:\6955 (Mod 3) Granite Entrance Station Pre-|

Mod  print (Ctrl+P) duction Drawing An

— Print to a printer or to a file oy Y
& [None Prlnt icon ‘ s
Atach B ~ & ¥ o
= Explorer ach - Element ence
? Tools~ %5 = 55 v Selection Tools ~
Attributes Primary Selection
ﬂ Print (FLH_Standard_PDF pltcfg) — X
File | Settings Resymbolization
Open Print Definition File... <
Save Print Definition File...
Preview
Print... b
Select Printer Driver Configuration
Select Windows Printer N
Configure Windows Printer From the File drop-down,
Edit Printer Driver Configuration Sel ect
Reload Printer Driver Ct:\nﬁguratit:nlré = = H = =
= Edit Printer Driver Configuration
EKE |_—‘ Rasterized | |
View: |View 1 o
- - - - -
Color: |l .J FLH_Standard_PDF.pltcfg* - Printer Driver Configuration *

General Base Properties Paper Sizes ColorMaps WeightMaps Line Stvles FontMaps Proarams

Save Fi
C:\ rﬁmDﬁlﬁ‘ \Bentley\OpenRoads D ization-Civil\FLH_Stds-
Save As.. IJ\\) WlST rmtlng‘PID\t Config\FLH_ S e I ect t h e

E .
Driver:

General tab

Pen Bentley PDF printer driver

Designs [ Display Label:
Adobe_PDF_Custom Paper Sizes|

MNotes:
This is the Bentley printer driver used to create Ado

The printer driver configuration may be customized | content along with links and bookmarks.

Rename the
Display Label
text

Perform a

Save As... of the

Printer Driver Configuration

Rename the file.

Place the Renamed File on
the C:/ Drive.
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After performing a Save As of the Printer Driver Configuration file, select the Paper Sizes tab to create a

custom Paper Size.

ﬂ Select the

- -
=) FLH_Standard_PDF_Custom P, - Exit »X
<J Paper Sizes tab
File
Mew... s PaperSizes ColorMaps WeightMaps Line Styles FontMaps Programs
Open...
E— Save the
Save A, ¥ s| Printer Configuration File }inscale weights.. style Scal A
Exit 594, 420 mm
SO 420, 297 mm
ISO A4 297 210 mm Edit Paper Size(s) »
ArchE1 Assign the custom | .
ArchE ) Paper size name: |CUSTUmP3PETS|ZE| ‘
ArchD Paper Size a Name
ArchC 24 18 in. [ L] Windows form name:
Arch B ; H
oA Define the Width Overal papersize: |42 | 500 i
ANSIE and Length of the | |
ANSID custom Paper Size | "eremmeEne in
17 11, i Rightftop margins: in.
112500, =
Select the [ein Hts: (S
Add buttﬂ'n ;:: [] Default print scale:
Avenza NEW 200,100 in L] Line weight scale:
Custom Paper Size 42, 500 in. '
L] Line style scale:
Edit... Add'L\,.’ Removg L] Automatic rotation: | Clockwise
[ ]Is default paper size
Select OK Cancel
|

IMPORTANT: Before printing with the custom Paper Size, the Print Configuration File (created on the

previous page) must be loaded in the Print settings.

Proceed to the next page.
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Before printing with the custom Paper Size, the Save As copy of the Print Configuration File must be
loaded in the Print settings.

From the File drop-down, use the Select Printer Driver Configuration tool. Navigate to the file
location specified in Step 5.

After loading the copied Print Configuration File, the custom Paper Size will be shown in the Paper Size

drop-down.

From the File drop-down, use the

Open Print Definition File...
Save Print Definition File...
Preview
Print...

=) print (FLH_Standard. PO Select Print Driver Configuration

rint (FLH_Standard_ tOO'.

Navigate to the File Location
specified in Step |E}

rinter and

& Adglle_PDF_Custom Paper Sizes

Select Printer Driver Configuration

ey PDF printer driver

Select Windows Printer

Configure Windows Printer

Edit Printer Driver Configuration

Reload Printer Driver Configuration

Exit

%Custom Paper Size

ANSI E “
ANSID
ANSIC
ANSI B
ANSIA
Long-22
Long-34
Avenza
: Select the 1
Custom Paper Size . -,
Custom Paper Size
Scale: | 0.8723 Rotation: | None hd
Size: | 248.027 42,000 in. Iﬂ Maximize
Origin: | 0.000 0.000 in. [ ] Auto-center
Pen table: | Blacktbl . P X
Design script:
Printto File.. |
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19F.4 Update All Fields in an ORD File

To refresh all Fields found in the currently opened ORD File use the following Key-in: “field update all
file”.

NOTE: When this Key-in is ran, all Fields in the 2D Design Model QJ, Drawing Models @, and
Sheet Models [3 are updated.
o Open the desired ORD File to update Fields in.

From the Ribbon, select the Key-in tool:
[OpenRoads Modeling -» Home - Primary].

E In the location shown below, manually type in “field update all file”.

Then, push the Enter key.

EJ OpenRoads Modeling v V8~ HE L e Sk be i =
Home Terrain Geometry Site Corridors Model Detailing Drawing Production Drawing Ut
_ — & - = - Sy
# None v | Default E Q [ . * b I
r.‘ ‘-h bossd
o ~(zo ~|(|=Z0 ~|@o ~|o | Bdwplorer Attach ‘}I} Element Fence
= = ki v

Tools v _§50 Selection Tools* ) ~
Attributes 6'3:‘ Key-in % n

Toggle AccuDraw

f;n: Auxiliary Coordinates
@ Saved Views
< Cells
Type in )
- . = Mark
"field update all file" | "™
p= Details
Push the Enter key. EJ Window List

Key-in n

field update all file| i v
facet A || |lupdate all file

facetdlg select model

featuremanager

fence

field v

< > All he

field update all file
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19G - CROSS SECTION PRINTING WORKFLOW

This workflow is shown in Z6I = Print Cross Sections.
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